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Overview 

Stellar MBOX to PST Converter - Technical converts mailbox from Thunderbird, Spicebird, Entourage, 

Pocomail, Eudora, AppleMail, Mulberry, SeaMonkey, Netscape, ClawsMail, OperaMail, MozillaMail, 

Evolution, Sylpheed, Cone, Mutt, and Gnu Mail files to Outlook mailbox (PST files). You can see the 

preview of converted mails after successful completion of conversion process. 

 

The software gives option to save the converted mails to a new or existing Outlook PST file. 

 

What's new in this version? 

 Option to save the converted file in Office 365, EML, MSG, RTF, PDF and HTML formats. 

Key Features of Stellar MBOX to PST Converter 

 User friendly and secure software. 

 Converts Thunderbird files to Outlook PST files. 

 Converts Cone to Outlook PST files. 

 Converts Mutt files to Outlook PST files. 

 Converts Gnu Mail files to Outlook PST files. 

 Converts Spicebird files to Outlook PST files. 

 Converts Entourage files to Outlook PST files. 

 Converts Pocomail files to Outlook PST files. 

 Converts Eudora files to Outlook PST files. 

 Converts AppleMail files to Outlook PST files. 

 Converts Mulberry files to Outlook PST files. 

 Converts SeaMonkey files to Outlook PST files. 

 Converts Netscape files to Outlook PST files. 

 Converts ClawsMail files to Outlook PST files. 

 Converts OperaMail files to Outlook PST files. 

 Converts MozillaMail files to Outlook PST files. 

 Converts Evolution files to Outlook PST files. 

 Converts Sylpheed files to Outlook PST files. 

 Provides preview of mails. 

 Log Report. 
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Installation Procedure 
 
Before installing the software, check that your system meets the minimum system requirements: 

Minimum System Requirements 

 Processor: Pentium Class 

 Operating   System: Windows 8 /  Windows 7 / Windows Vista / Windows 2003-2008 Server / 

Windows XP  

 Microsoft Office: Office 365, 2013, 2010, 2007, 2003 

 Memory: Minimum 1 GB 

 Hard Disk: 50 MB of Free Space 

To install the software, follow these steps: 

 Double-click StellarMBOXtoPSTConverter.exe executable file to start installation. Setup - 

Stellar MBOX to PST Converter - Technical dialog box is displayed.  

 Click Next. License Agreement dialog box is displayed. 

 Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

 Click Browse to select the destination path where the setup files will be stored. Click Next. 

Select Start Menu Folder dialog box is displayed. 

 Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks 

dialog box is displayed. 

 Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed.  

 Review the entries. Click Back if you want to change them. Click Install to start installation. The 

Installing window shows the installation process. 

 After completing the process, Completing the Stellar MBOX to PST Converter - Technical 

Setup Wizard window is displayed. Click Finish. 

 

Note: Clear Launch Stellar MBOX to PST Converter - Technical check box before clicking Finish to 

prevent the software from launching. 
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Launching the Software 

 

You can use any of the following methods to start Stellar MBOX to PST Converter - Technical:  

 Click Start -> Programs -> Stellar MBOX to PST Converter - Technical -> Stellar MBOX to 

PST Converter - Technical.  

 Double click on Stellar MBOX to PST Converter - Technical icon on Desktop.  

 Click Stellar MBOX to PST Converter - Technical icon in Quick Launch. 
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User Interface 

Stellar MBOX to PST Converter - Technical software has a very easy to use Graphical User Interface. 

The user interface contains features required for conversion. 

 

After launching the program, you will see the main user interface as shown below: 

 

 

 

The user interface contains menus and buttons that lets you access various features of the software with 

ease.  



6 

Menus 

File 

Select Mail Client 
Use this option to open Select Mail Client to be 
Converted dialog box. 
 
Save Converted Mailbox 
Use this option to access the Save File Option. 
 
Exit 
Use this option to exit the application. 

 

 

File Menu 

View 

Log Report 

Use this option to view and save log report 

 

 

View Menu 

Activation 

Activate Stellar MBOX to PST Converter - 

Technical 

Use this option to activate the product.  

 

Activation Menu 

 

Help 
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Stellar MBOX to PST Converter -

Technical Help 

Use this option to see user help

guide. 

 

Purchase Stellar MBOX to PST

Converter - Technical 

Use this option to buy Stellar 

MBOX to PST Converter -

Technical. 

 

View Support Section 

Use this option to visit support page

of stellarinfo.com. 

 

View Knowledge Base  

Use this option to visit

knowledgebase articles of

stellarinfo.com. 

 

Submit Enquiry 

Use this option to submit enquiry to 

stellarinfo.com. 

   

About Stellar MBOX to PST

Converter - Technical 

Use this option to read information

about the software 

. 

  

 

Help Menu 
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Buttons 

 

 

Select Mail 

Client  

 

 

Click this button to open Select Mail Client to be Converted dialog box. 

 

 

Save 

Converted 

Mailbox 

 

 

 

Click this button to access the Save File Option. 

 

 

Help 

 

 

 

Click this button to access the User Guide.  

 

 

Update Wizard  

 

 

 

Click this button to check for both, latest minor and major version available online.  

 

 

Purchase 

 

 

 

Click this button to purchase the software.  

 

 

About 

 

 

 

Click this button to know about the software.  
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Ordering the Software 

 
To purchase the software online, please visit  http://www.stellarinfo.com/email-tools/mbox-to-pst-

converter/buy-now.php and place an order. 

Alternatively, click Purchase button on the application tool bar to purchase the software online.  

Select any of the methods given above to go further with the purchasing process. 

Once the order is confirmed, a serial number will be sent through e-mail, which would be required to 

activate the software. 

  



10 

Activating the Software 

You can download demo version of Stellar MBOX to PST Converter - Technical software from here. 

The demo version is just for evaluation purposes and you must eventually register the software to use its 

full functionality. Once you purchase the software, you will receive a key using which you can register the 

software.  

You can activate the software using any of the following methods: 

 Online Activation 

After purchasing the software, a serial number will be sent via email, which is required to activate 

the software. You need to enter the serial number which is then verified by a license server and on 

verification the software is activated. 

 Manual Activation 

To activate the software manually, you will need to generate a PHX_REG.txt file and mail it to 

support@stellarinfo.com. After verification of the serial number and purchase details, the site key, 

which is required to activate the software manually, will be sent to your email address. 

 

Note: If the software is downloaded from http://www.stellarinfo.com/email-tools/mbox-to-pst-

converter/buy-now.php (i.e. ESD version), it must be activated using Serial Number (received through 

email after purchasing the product) to use all the features of the software. 

If the software is installed using the product installation CD (i.e., BOX version), hardware lock, that is 

available with the software kit, is mandatory for the functioning of the software. 
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Online Registration 

 
To register the software online: 

1. Launch demo version of Stellar MBOX to PST Converter - Technical software. 

2. From Menu bar, select Activation. Click Activate Stellar MBOX to PST Converter - Technical. 

3. In Activation Option dialog box, select I have the registration key. 

4. Select Online Activation. Click OK. A warning will appear, click OK to continue. 

 

5. In Stellar Phoenix - Electronic Software Registration wizard, click Next. 

6. Type the serial number (received through email after purchasing the product) in serial number 

field. Click Next. 

7. The software would automatically communicate with the license server. After the registration is 

done, click Finish to complete the registration process. 

 

Note: You can generate PHX_REG.txt file manually via online activation. View Manual Registration to 

perform the process of generating PHX_REG.txt file. 
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Manual Registration 

 
To register the software manually: 

1. Launch demo version of Stellar MBOX to PST Converter - Technical. 

2. From Menu bar, select Activation option. Click Activate Stellar MBOX to PST Converter - 

Technical. 

3. In Activation Option dialog box, select I have the registration key. 

4. Select Online Activation. Click OK. A warning will appear, click OK to continue. 

5. In Stellar Phoenix - Electronic Software Registration wizard, click Cancel. 

6. Stellar MBOX to PST Converter - Technical dialog box will open, click Yes. 

7. In Manual Software Registration dialog box, enter the serial number that you receive once you 

purchase the software. Click Next. 

 

8. A file named PHX_REG.txt is created on your desktop. Click Finished. Email it to 

support@stellarinfo.com. 
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9. After verifying the purchase details, you will receive the site key, which is required to register the 

software manually. 

10. After receiving the Site Key, open Stellar MBOX to PST Converter - Technical. In Activation 

Option dialog box, select I have the registration key. 

11. Select Manual Registration and click OK. 

12. Enter the Site Key in Stellar MBOX to PST Converter - Technical dialog box. Click Validate. 

Note: The site key is delivered to the email address through which the serial number is sent. 
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Updating the Software 

 

There are periodical software updates for Stellar MBOX to PST Converter. The software updates should 

be done to keep the software up-to-date. The updates can be a newly added functionality, a new feature, 

a new service, or any other information that can be important for improvement. Update option in the 

application is capable of checking for the latest updates. This will check for both latest minor and major 

version available online. You can easily download minor version through the update wizard. However, the 

major version, if available, has to be purchased. While updating the software, it’s recommended to close 

all the running programs. Note that demo version cannot be updated.  

To update the application, follow these steps: 

 Click on Update Wizard button in application tool bar. Update Wizard is displayed. 

 Click Next. A busy timer shows that updates are being searched. If any new version is found, a 

message indicates its availability.  

 If a message is displayed that no updates are available, Click Cancel to close the wizard. 

 Click Next. The software will start downloading the update files from the server. When the 

process is complete, the software will upgrade to the latest version.  

  



15 

Uninstalling the Software 

 

You can use any of the following options to uninstall Stellar MBOX to PST Converter - Technical:  

 Click Start -> All Programs -> Stellar MBOX to PST Converter - Technical -> Uninstall 

Stellar MBOX to PST Converter - Technical. Follow on screen instructions to completely 

remove the software, including registry entries from your computer.  

Or, 

 Click Start -> Control Panel -> Add Or remove Program. Select Stellar MBOX to PST 

Converter - Technical entry from the displayed list and click Change/Remove. Follow on 

screen instructions to completely remove the software as well as registry entries from your 

computer. 
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Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products.  

You can either call us or go online to our support section at http://stellarinfo.com/support/. 

For price details and to place the order, click https://www.regnow.com/checkout/cart/add/5388-58. 

Chat Live with an Online technician at http://stellarinfo.com/support/. 

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb/. 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php. 

E-mail to Stellar Support at support@stellarinfo.com. 

 

 

 

Support Helpline 

Monday to Friday [24 Hrs. a day] 

USA (Tollfree- Pre Sales Queries)USA 
(Post Sales Queries) 

UK (Europe) 
Australia & Asia Pacific 

Netherlands Pre & Post Sales Support 
Worldwide 

Email Orders 

+1-877-778-6087 
+1-732-584-2700 
+44-203-026-5337 
+61-280-149-899 
+31-208-111-188 
+91-124-432-6777 
orders@stellarinfo.com  
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Select File(s)/Identity 

To select MBOX file / Identity: 

 Launch Stellar MBOX to PST Converter. Select Mail Client to be Converted dialog box is 

displayed as shown below: 

 

 

 

 Click on the desired Mail Client icon. 

  Select File/Folder dialog box opens as shown below:  

 

 

 

 Click Select File/Select Identity Folder button and locate file/Identity. 

 Selected file/Identity path is displayed in Select File/Folder Path text box. 

 Click Convert button to start the conversion process. 

 

Note: You can only select a complete Identity folder for the following mail clients: Apple Mail, ClawsMail, 

MozillaMail, OperaMail, Sylpheed.  
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Find Files 

You can search for MBOX, MBX, MacMBOX, and AppleMail files using Find File Option in Select 

File/Folder dialog box. You can search for files in drives, folders and sub folders. However, you can select 

only one drive at a time to search for files. 

To search for MBOX, MBX, MacMBOX, and AppleMail files: 

 Click Find File Option in Select File/Folder dialog box. 

 Browse for Folder dialog box opens. 

 Select the required drive/folder/sub folder and click OK to search for files.  

 After the search is finished, list of MBOX/MBX/MacMBOX/AppleMail files found in the selected 

drive/folder/sub folder is shown in Select files dialog box as shown below: 

 

 

 

 Select files you wish to convert from this list and then click Convert to start the conversion process.  
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Preview of Mails 

 
You can see the preview of converted mails after successful completion of conversion process. Left pane 

displays selected MBOX filename under Root node in a tree like structure. Upper right pane displays the 

list of converted mails. To see content of desired mail, click on it in upper right pane. The content is 

displayed in lower right pane as shown below. 
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Save Converted Mails 

To save converted mails to PST format: 

 Click Convert button on the tool bar or select Convert option in the File menu. Select PST radio 

button and click OK. 

 

 

 Save File dialog box opens as shown below. 

 

 

 

 To save converted mails into a new PST file: 

 Select Save as new Outlook PST File and click Browse.  

 Browse for Folder dialog box opens. Select location for saving PST file and click 

OK. 

 The converted mails will be saved into a new PST file at the specified location. 
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 To save converted mails into an existing PST file: 

 Select Append data into existing profile/PST file. Select Profile and PST dialog 

box appears as shown below: 

 

 

 

 To add the converted mails to an existing Outlook profile, choose Select Outlook 

Profile to add converted mails and select one of the profiles that appear in the 

list. Click OK. 

Or,  

To add the converted mails to an existing Outlook PST file, choose Select Outlook 

PST file to add converted mails and then click Browse to select the PST File. Click 

OK.  

 The converted mails will be saved into the selected Outlook Profile / Outlook PST 

file. 

To save converted mails to Office 365 format: 
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 Click Convert button on the tool bar or select Convert option in the File menu. Select Office 365 

radio button and click OK. 

 

 

 

 Connect to Office 365 dialog box opens. Login by entering the E-Mail ID and Password and 

click OK. 

 

 

 

To save converted mails to MSG or EML or RTF or PDF or HTML format: 

 Click Convert button on the tool bar or select Convert option in the File menu. Select either 

MSG or EML or RTF or PDF or HTML radio button and click OK. 
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 Stellar MBOX to PST Converter dialog box opens. Click Browse to go to the folder where you 

want to save the converted mails and click OK. 
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Import PST files in MS Outlook 

 

To import PST files in Microsoft Outlook 2010:  

 Open Microsoft Outlook. In the File Menu, select Open -> Import. 

 In the Import and Export Wizard, select Import from another program or file, click Next. 

 In the Import a File dialog box, select Outlook Data File (.pst), click Next.  

 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In the Import Outlook Data File dialog box, select the folders that should be imported in 

Microsoft Outlook. Click Finish. 

To import PST files in Microsoft Outlook 2007 / 2003: 

 Open Microsoft Outlook. In the File menu, select Import and Export. 

 In the Import and Export Wizard, select Import from another program or file, click Next. 

 In the Import a File dialog box, select Personal Folder File (PST), click Next. 

 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In the Import Personal Folders dialog box, select the folders that should be imported in 

Microsoft Outlook. Click Finish.  
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View & Save Log Report 

 

During and after completion of the conversion process, you can see log details in bottom window of 

Stellar MBOX to PST Converter - Technical. The Log Report window displays beginning of the process, 

end of the process, name of the file etc. during running of the process. With Stellar MBOX to PST 

Converter - Technical, you can save Log Report to analyze recovery process at a later stage. 

   
 To view log details, click Log Report in View menu on the menu bar. Log Report window opens 

as given below. 

 

 

 

 Click Save Log button to save log report. Enter file name and choose destination in Save As 

dialog box.  

 

 Click Clear Log button to clear Log Report. 

 

 Click Close button to close Log Report. 
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FAQs 

 
1. What does the demo version of the software do? 

In demo version of the software, you will be able to see the mail body but cannot open 
attachments. To view / save all data and open attachments, you need to purchase and activate the 
software. 
 

2. What is MBOX file format? 
The MBOX file is the most common format for storing email messages on a hard drive. All the 
messages for each mailbox are stored as a single, long, text file in a string of concatenated e-mail 
messages, starting with the From header of the message. 

   
An MBOX is a text file containing an arbitrary number of e-mail messages. Each message consists 
of a postmark, followed by an e-mail message formatted according to RFC 822. The file format is 
line-oriented. Lines are separated by line feed characters (ASCII 10). A postmark line consists of 
the four characters From, followed by a space character, followed by the message's envelope 
sender address, followed by white space, and followed by a time stamp. The sender address is 
expected to be an addrspec as defined in appendix D of RFC 822. 
The date is expected to be formatted according to the syntax represented in the augmented 
Backus-Naur formalism used by RFC 822. 
 

3. Which email clients are supported by Stellar MBOX to PST Converter - Technical? 
Stellar MBOX to PST Converter - Technical supports Thunderbird, Spicebird, Entourage, 
Pocomail, Eudora, AppleMail,  Mulberry, SeaMonkey, Netscape, ClawsMail, OperaMail, 
MozillaMail, Evolution, Sylpheed, Cone, Mutt and Gnu files. 

 
4. Can I convert a single mail into PST file? 

You can only convert a complete MBOX file.  
 

5. If the location of MBOX files are not known, can I search for then using Stellar MBOX to 
PST Converter - Technical? 
Yes, Find File option of the software lets you search for MBOX files in specified drive of the 
computer. To know how to use this option, please refer Find Files topic of help manual. 

 
6. Can I convert multiple MBOX files simultaneously? 

Yes. 
 

7. I want to save converted mails into an existing PST file. How can I do it? 
Stellar MBOX to PST Converter - Technical gives you option to save converted mails into an 
existing or new PST file. For full details, please refer Save Converted Mails topic of this help 
manual. 
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Legal Notices 

Copyright 

Stellar MBOX to PST Converter - Technical software, accompanied user manual and documentation are 

copyright of Stellar Information Technology Private Limited, with all rights reserved. Under the copyright 

laws, this user manual cannot be reproduced in any form without the prior written permission of Stellar 

Information Technology Private Limited. No Patent Liability is assumed, however, with respect to the use 

of the information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar MBOX to PST Converter - Technical® is a registered trademark of Stellar Information Technology 

Private Limited. 
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Windows 2000 Server®, Windows XP®, Windows 2003®, Windows Vista®, Windows 7®, Windows 8® 
are registered trademarks of Microsoft® Corporation Inc. 
All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

License Agreement 

Stellar MBOX to PST Converter - Technical 

Copyright © Stellar Information Technology Private Limited. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar MBOX to PST Converter - Technical. 

 

Your Agreement to this License 

 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar MBOX to PST Converter - Technical with which this License is included, you may 

return the complete package unused without requesting an activation key within 30 days after purchase 

for a full refund of your payment. 

 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar MBOX to PST Converter - Technical. For purposes of this License, if you have a valid single-user 

license, you have the right to use a single Licensed Copy of Stellar MBOX to PST Converter - Technical. 

If you or your organization has a valid multi-user license, then you or your organization has the right to 

use up to a number of Licensed Copies of Stellar MBOX to PST Converter - Technical equal to the 

number of copies indicated in the documents issued by Stellar Information Technology Private Limited 

when granting the license. 

 

Scope of License 
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Each Licensed Copy of Stellar MBOX to PST Converter - Technical may either be used by a single 

person or used non-simultaneously by multiple people who use the software personally installed on a 

single workstation. This is not a concurrent use license. 

 

All rights of any kind in Stellar MBOX to PST Converter - Technical, which are not expressly granted in 

this license, are entirely and exclusively reserved to and by Stellar Information Technology Private 

Limited. You may not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create 

derivative works based on Stellar MBOX to PST Converter - Technical nor permit anyone else to do so. 

You may not make access to Stellar MBOX to PST Converter - Technical available to others in 

connection with a service bureau, application service provider or similar business nor permit anyone else 

to do so. 

 

Warranty Disclaimers and Liability Limitations 

 

Stellar MBOX to PST Converter - Technical and all accompanying software, files, data and materials are 

distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. You 

acknowledge that good data processing procedure dictates that any program including Stellar MBOX to 

PST Converter - Technical must be thoroughly tested with non-critical data before there is any reliance on 

it and you hereby assume the entire risk of all use of the copies of Stellar MBOX to PST Converter - 

Technical covered by this License. This disclaimer of warranty constitutes an essential part of this 

License. In addition, in no event does Stellar Information Technology Private Limited authorize you or 

anyone else to use Stellar MBOX to PST Converter - Technical in applications or systems where its 

failure to perform can reasonably be expected to result in a significant physical injury or in loss of life. Any 

such use is entirely at your own risk and you agree to hold Stellar Information Technology Private Limited 

harmless from any and all claims or losses relating to such unauthorized use. 

 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

 

General 
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This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar Information Technology Private Limited 

herein. Any waiver by Stellar Information Technology Private Limited of any violation of this License by 

you shall not constitute nor contribute to a waiver by Stellar Information Technology Private Limited of any 

other or future violation of the same provision or any other provision of this License. 

 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 
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About Stellar 

 
Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data 

Protection Software for more than a decade.  

 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for 

almost all Operating Systems and File Systems. 

Product line:  

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

 

E-mail Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail. 

More Info >> 

 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

 

For more information about us, please visit www.stellarinfo.com 

 


